
PrePoMax 1.2.1 Manual

Jakub Michalski, Matej Borovinšek and Ihor Rokach

February 28, 2022



PREPOMAX 1.2.1 MANUAL — V.1.0.0, FEBRUARY 28, 2022

Contents

1 What is PrePoMax? 3

2 Currently available analysis features 3

3 Workflow, general options 5
3.1 File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
3.2 Edit Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
3.3 View Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
3.4 Tools Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
3.5 Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4 Geometry and mesh options 12
4.1 Geometry Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
4.2 Mesh Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

5 FE Model options 14
5.1 Model Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
5.2 Property Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

5.2.1 Library materials section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
5.2.2 FE model materials section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
5.2.3 Using the material library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
5.2.4 Exchanging material data between users . . . . . . . . . . . . . . . . . . . . . . . . 19

5.3 Interaction Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
5.4 Initial Condition Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
5.5 Step Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

5.5.1 Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
5.5.2 History Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
5.5.3 Field Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
5.5.4 Boundary condition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
5.5.5 Load . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
5.5.6 Defined Field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5.6 Analysis Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

6 Results options 36
6.1 Results Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

2



PREPOMAX 1.2.1 MANUAL — V.1.0.0, FEBRUARY 28, 2022

1 What is PrePoMax?

PrePoMax is an open-source pre- and postprocessor for also open-source Finite Element Analysis
solver CalculiX CrunchiX. PrePoMax is being developed by Dr. Matej Borovinšek from University of
Maribor, Slovenia. The current stable version is 1.2.1. Source code of the development version of
the program is available at GitLab. PrePoMax offers a very user-friendly GUI and supports many
features provided by the CalculiX solver. It can be downloaded from the following website: https:
//prepomax.fs.um.si/. User forum is available here: https://prepomax.discourse.group/.

Figure 1: PrePoMax user interface

2 Currently available analysis features

• Analysis step types:

– Static

– Natural frequency extraction

– Linear buckling

– Heat transfer

– Uncoupled temperature-displacement

– Coupled temperature-displacement

• Finite element types:

– Solid tetrahedrons (first and second order)

– Shell triangles or quadrilaterals (first and second order)

– Membrane triangles or quadrilaterals (first and second order)

– Plane stress triangles or quadrilaterals (first and second order)

– Plane strain triangles or quadrilaterals (first and second order)
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– Axisymmetric triangles or quadrilaterals (first and second order)

– Import of solid wedges (first and second order)

– Import of solid hexahedrons (first and second order)

• Material models (isotropic, with optional temperature dependency):

– Linear elasticity

– Plasticity

– Thermal

• Constraints:

– Point spring

– Surface spring

– Rigid body

– Tie

• Interactions:

– Contact

* Friction

* Gap conductance

• Initial conditions

– Temperature

• Boundary conditions:

– Fixed

– Displacement/Rotation

– Submodel

– Temperature

• Loads:

– Concentrated force

– Moment

– Pressure

– Surface traction

– Normal shell edge load

– Gravity

– Centrifugal load

– Pre-tension

– Concentrated flux

– Surface flux

– Body flux

– Convective film

– Radiation
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(a) Geometry tab of the model
tree

(b) FE Model tab of the model
tree

(c) Results tab of the model tree

Figure 2: Three PrePoMax tabs

3 Workflow, general options

In PrePoMax, three tabs of the model tree dictate the workflow in this software:

1. Geometry – geometry editing and mesh generation (Figure 2a).

2. FE Model – analysis set up (pre-processing), see Figure 2b.

3. Results – post-processing (Figure 2c).

Each tab also activates proper menus in the top toolbar.
The general steps that should be followed when working in PrePoMax are listed below:

1. Create a new model ( File New ) and select a model space and unit system.

2. Import CAD geometry for the analysis ( File Import ).

3. Set mesh parameters ( Mesh Meshing Parameters ) and generate a mesh ( Mesh Create Mesh ).

4. When the mesh is successfully created, proceed to the FE Model part of the model tree.

5. Define material for the analysis ( Materials Create ), add proper material behaviors: Elasticity,
Density (for performing a modal analysis or using gravity or centrifugal loads), Plasticity (to
account for permanent deformations) and/or Thermal.

6. Create a new section with the material defined before ( Section Create ). Section type can be
Solid (for using 3D or 2D solid elements), Shell (for using shell elements) or Membrane (for us-
ing membrane elements). The thickness must also be specified if shell, membrane or plane
stress/strain elements are used. Select the part to assign the section to it.

7. Create a new analysis step. Default step settings are sufficient in most cases.
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8. Optional: create constraints ( Constraints Create ), define contact (expand Contact container,
select Surface Interactions Create and then select Contact pairs Create ) and/or initial condition
( Initial condition Create ).

9. Define boundary conditions ( BCs Create ) and loads ( Loads Create ). There are several types
available, and they can be applied to the model in different ways (discussed later).

10. Submit the analysis ( Analysis-1 Run ), when it finishes, the results can be viewed ( Analysis-1
Results ). Various post-processing options will be explained later.

In PrePoMax, it’s advised to work using node and elements sets as well as surfaces. They can be
defined before any boundary condition, load, constraint or contact is created and then referenced
in the definition of the selected feature. However, it’s also possible to add features without creating
sets/surfaces first. In such cases, the selection tool within the feature window will let the user pick
entities based on geometry or mesh, depending on the type of feature.

There are two main ways to work in PrePoMax – use options available in menus (menu bar and
top toolbar) or select them in the model tree. Some more advanced options can be accessed only
from the menu bar.

View controls in PrePoMax:

• zoom: mouse scroll;

• rotate model: middle mouse button or keyboard arrows;

• pan (move model): Shift + middle mouse button.

For selection, use the left mouse button (drag the mouse to use the selection box). Holding Shift

when selecting adds entities while holding Ctrl removes them.
A search bar is available on top of each of the three main tabs. It can be used to filter geometry, FE

model and results trees.
In the case of failure (when PrePoMax suddenly closes), the user is asked if a crash recovery file

should be used to regenerate the previous session.

3.1 File Menu

Figure 3: File menu

The File menu (Figure 3) contains the following options:
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• New ( Ctrl + N ) – create a new model. The model space can be 3D, 2D Plane Stress, 2D Plane
Strain or 2D Axisymmetric. The following unit systems are available (derived units are listed
when a unit system is selected):

– Unitless,

– m, kg, s, °C – standard SI units,

– mm, ton, s, °C – unit set typical for mechanical engineering,

– m, ton, s, °C,

– in, lb, s, °C – imperial units.

• Open ( Ctrl + O ) – open a previously created model.

• Open Recent – open one of the recently used models or clear the list of the recent files.

• Import ( Ctrl + I ) – import CAD geometry, mesh or model saved in one of the following for-
mats:

– STEP,

– IGES,

– B-rep,

– STL,

– Universal,

– Netgen,

– Abaqus/CalculiX inp-file,

– Mmg mesh.

• Save ( Ctrl + S ) – save changes in the current model.

• Save As – save the model as .pmx file with a given name.

• Export – export part/model in one of the following formats:

– CalculiX input file,

– Abaqus input file,

– STEP,

– B-rep,

– Mmg,

– STL - can be used to export the mesh and the deformed result parts.

• Close Results – close the results from the post-processing part of the model tree (saving the pmx
model without the results reduces the file size).

• Exit ( Ctrl + F4 ) – close PrePoMax (the user will be asked if the model should be saved first).
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Figure 4: Edit menu

3.2 Edit Menu

The Edit menu (Figure 4) contains the following options:

• Undo – undo the last action.

• Redo – redo the action that was undone previously.

• View History – open text file with history of user actions.

• Regenerate – regenerate the model in case of errors.

• Regenerate Using Other Files – swap the model’s geometry with a similar one from another file
so that it is not necessary to redefine the model.

• Regenerate for Remeshing – remesh the model while keeping all the node sets, element sets
and surface data defined using mesh-based selections (the model can be remeshed without
the need to redefine the geometry-based selections).

3.3 View Menu

The View menu (Figure 5) contains the following options:

• Standard Views – apply one of the predefined views:

– Front or Back,

– Top or Bottom,

– Left or Right,

– Normal,

– Vertical,

– Isometric.

• Zoom to Fit – zoom the model in such a way that it fits in the window.

• Wireframe – apply a view showing only model edges.

• Show Element Edges – apply a view showing the model with the finite element edges.

• Show Model Edges – apply a view showing the model and its feature edges.

• No Edges – apply a view showing the model with no edges.
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Figure 5: View menu

• Section View – cut the model using a plane defined by a point and a normal or disable the
section view (this option can be used in post-processing as well).

• Exploded View – show assembly parts in an exploded view (select exploded view style, magnifi-
cation and scale factor).

• Show All – show (unhide) all parts of the model.

• Hide All – hide all parts of the model.

• Invert Visible Parts – invert the visibility of parts.

• Undeformed – show undeformed result part.

• Deformed – show deformed result part.

• Deformed with Color Contours – show deformed result part with contour plot.

• Color Annotations – use colors to distinguish items of the model based on various criteria.

Figure 6: File and View toolbars

Selected options from the File and View menus can be accessed directly using a toolbar menu
shown in Figure 6.
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Figure 7: Tools menu

3.4 Tools Menu

The Tools menu (Figure 7) contains the following options:

• Settings

– General

* Open last file, last file name.

* Save results in .pmx files.

* Default unit system.

* Import mesh → Edge angle.

– Graphics

* Background: Type, Top color, Bottom color.

* Geometry: CAD deflection.

* Lighting: Ambient component, diffuse component.

* Smoothing: Point smoothing, Line smoothing.

* Widgets: Coordinate system visibility, Scale widget visibility.

– Default Colors

* Face orientation: Front face color, Back face color.

* General.

– Meshing – default settings for meshing

* Mesh size: Grading, Elements per edge, Elements per curvature,

* Mesh optimization: Optimize steps 2D, Optimize steps 3D,

* Mesh type: Second order, Midside nodes on geometry, Quad-dominated mesh,

* Mesh operations: Split compound mesh.

– Pre-processing

* Color bar: Background type, Draw a border rectangle.

* Selection: Primary/secondary/mouse highlight color.

* Symbols: Constraints/BCs/Loads color, Symbol size, Node symbol size, Draw symbol
edges.

– Calculix

* Calculix: Work directory, Use .pmx folder as work directory, Executable, Default solver.

* Parallelization: Number of processors, Environment variables.

– Post-processing

* Deformation

· Deformation scale factor: Automatic/True scale/Off/User defined,

· Draw undeformed model: Yes/No,

· Draw undeformed model as: Wireframe body/Shaded body

· Undeformed model color.
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* Limit values

· Show max value location: Yes/No,

· Show min value location: Yes/No.

* History output

· Max number of the history output entries.

– Legend

* Color spectrum settings

· Color spectrum type: Cool-warm, Rainbow, Warm, Cool, Cividis, Viridis, Plasma,
Black body, Inferno, KindImann, Grayscale,

· Brightness,

· Reverse colors: Yes/No,

· Number of discrete colors – in the range of 2-24.

* Color spectrum values

· Number format: Scientific/General,

· Number of signi�cant digits – in the range of 2-8,

· Min/Max limit type: Automatic/Manual.

* Design

· Background type: None/White,

· Draw a border rectangle: Yes/No.

– Status block

* Design

· Background type: None/White,

· Draw a border rectangle: Yes/No.

• Query

– Point/Node – check the node ID and its value.

– Element – check the element ID.

– Edge – check the edge ID and its length.

– Surface – check the surface ID and its area.

– Part – check part information (name, type, number of nodes and elements).

– Assembly – check the number of parts, nodes and elements.

– Bounding box size – check the size of the model bounding box.

– Distance – measure the distance between two nodes.

– Angle – measure the angle using three points.

– Circle – measure the circle passing through three selected points.

3.5 Help Menu

The Help menu (Figure 8) contains the following options:

• Advisor – opens an interactive helper that will guide the user through the main steps to set up
the analysis in PrePoMax.

• Home Page – opens the PrePoMax website in the default browser.

• About – displays a title card.
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Figure 8: Help menu

4 Geometry and mesh options

The Geometry tab of the model tree features two main containers – Parts and Mesh Refinements. The
first one stores all parts in the model, and the following options are available when right clicking the
part:

• Edit – allows editing of the name and the color of the part.

• Meshing Parameters – displays the parameters for meshing.

• Preview Edge Mesh – displays points representing nodes in the mesh that will be generated (this
way, it can be determined whether the size of the mesh is sufficient or not before generating it).

• Create Mesh – starts the mesher and creates the finite element mesh for the part.

• Copy Geometry to Results – allows to display geometry parts in the post-processing.

• Hide/Show/Show Only – options to hide and show the selected part.

• Set Transparency – setting translucency color component of the part.

• Expand All/Collapse All – expands or collapses all objects listed in the Part container

• Delete – deletes the selected part.

4.1 Geometry Menu

Figure 9: Geometry menu

The Geometry menu (Figure 9) contains the following options:

• Part – general part geometry options:

– Edit,

– Transform,
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* Scale.

– Copy Geometry to Results,

– Hide/Show/Show Only,

– Set Transparency,

– Delete.

• CAD Part - CAD part geometry options:

– Flip Face Normal – flips the shell face orientation,

– Split a Face Using Two Points – divides a face using two selected points by projection.

• Stl Part - STL part geometry options:

– Find Model Edges by Angle – finds the model (feature) edges that fit into the specified
angle criterion,

– Flip Part Surfaces Normal – flips the orientation of the surfaces,

– Smooth Part – applies smoothing to STL part.

• Create Compound Part – merges two or more parts into one part (body).

• Regenerate Compound Part – regenerates a compound part.

• Swap Part Geometries – swaps part geometries between two parts.

• Analyze – checks the geometry for the following:

– Edges shorter than [speci�ed value],

– Edges closer than [speci�ed value],

– Faces smaller than [speci�ed value].

4.2 Mesh Menu

Figure 10: Mesh menu

The Mesh menu (Figure 10) contains the following options:

• Meshing Parameters – settings for the mesher:

– Mesh size

* Max element size,

* Min element size,

* Grading: 0 – uniform mesh, 1 – aggressive local grading,

* Elements per edge – number of elements per edge of the geometry,

* Elements per curvature – number of elements per curvature radius.

13
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– Mesh optimization

* Optimize steps 2D – number of optimization steps to use for the 2D mesh,

* Optimize steps 3D – number of optimization steps to use for the 3D mesh.

– Mesh type

* Second order: Yes/No,

* Midside nodes on geometry – project the midside nodes on the geometry, options:
Yes/No,

* Quad-dominated mesh: Yes/No (for shell and 2D parts only).

– Mesh operations

* Split compound mesh: Yes/No (splits compound part mesh to unconnected part meshes).

• Mesh Re�nement

– Create,

– Edit,

– Delete.

• Preview Edge Mesh

• Create Mesh

The Mesh refinement option can be used for local mesh controls. A surface, edge or vertex can be
selected, and local mesh size can be specified. The mesh refinement can be previewed before gener-
ating the mesh.

5 FE Model options

Switching to FE Model tab activates the following menus: Model , Property , Interaction , Initial condition ,
Step and Analysis . They can be used to define various FEM features. The same features can also be
created using the model tree.

5.1 Model Menu

Figure 11: Model menu

The Model menu (Figure 11) contains the following options:

14



PREPOMAX 1.2.1 MANUAL — V.1.0.0, FEBRUARY 28, 2022

• Edit

– Name,

– Model type: General or Submodel,

– Model space:

* for 3D models: 3D,

* for 2D models: 2D plane stress, 2D plane strain or 2D axisymmetric,

– Absolute zero – value of the absolute zero temperature used for radiation,

– Stefan-Boltzmann – value of the Stefan-Boltzmann constant used for radiation,

– Gravitational constant – value of the Newton’s gravitational constant.

• Edit CalculiX Keywords – a keyword editor that allows adding CalculiX keywords which are
currently unsupported by PrePoMax.

• Tools

– Create Boundary Layer – creates a prismatic boundary layer on the surface, the thickness
of the layer can be specified (used in analyses with a pre-tension load),

– Find Model Edges By Angle (searches for the feature edges based on the angle in the
imported meshes),

– Remesh Elements – remeshes the selected shell region using specified max/min element
size and max Hausdorff distance for boundaries approximation (0.01 is suitable for objects
of size 1 in all directions).

• Node

– Renumber All

* Start node id.

• Element

– Renumber All

* Start node id.

• Part

– Edit,

– Transform: Translate, Scale, Rotate,

– Merge,

– Hide, Show and Show Only,

– Set Transparency,

– Delete.

• Node set

– Create,

– Edit,

– Duplicate,

– Delete.
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• Element set

– Create,

– Edit,

– Duplicate,

– Convert to Part,

– Delete.

• Surface

– Create,

– Edit,

– Delete.

• Reference point

– Create,

– Edit,

– Delete.

Figure 12: Set selection window

When creating sets and surfaces, a Set selection window opens (Figure 12). Sets and surfaces are
named groups of nodes/elements and element faces used to define specific FEM features discussed
below. Geometry based selection is more limited in terms of features, but its definition is not lost
when the model is remeshed. FE mesh based selection offers more options, but if the model is
remeshed the selection definition becomes invalid since the mesh has changed.

Reference points can be created using one of the following methods:

• Selection/Coordinates,

• Between two points,

• Circle center by 3 points,

16



PREPOMAX 1.2.1 MANUAL — V.1.0.0, FEBRUARY 28, 2022

• Center of gravity,

• Bounding box center.

The user can also change the color of the reference point.

5.2 Property Menu

Figure 13: Property menu

The Property menu (Figure 13) contains the following options:

• Material

– Create,

– Edit,

– Duplicate,

– Delete.

• Material Library – several materials are built into PrePoMax and the user can add new materials
to the library as well.

• Section

– Create,

– Edit,

– Delete.

Material Library editor (Figure 14) allows access to materials library that is stored in the materi-
als.lib file in the base PrePoMax directory. The library file is a text-based file that can be edited using
any .txt editor, like Notepad++. It is assumed that all material data is stored using the mm, ton, s, °C
unit system. But the library file is not meant to be edited this way since it is created directly from the
material objects using JSON serialization and thus not easily readable.

The library is meant to be edited using the PrePoMax built-in material library editor shown in
Figure 15. The editor is divided in two sections, a section for library materials and a section for the
model materials.

5.2.1 Library materials section

The material library items consist of categories and materials. Categories are used to organize the
materials into smaller manageable groups. A new category can be created inside the existing category
using the Add category button and removed from the library using the Delete button. Each item in the
library can be renamed using the bottom text field and the Rename button. If changes were made
to the library, they must be saved using Save button. All materials inside one category must have a
unique name.

17
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Figure 14: Material library

5.2.2 FE model materials section

The section for the model materials contains only button Delete which is used to remove the materi-
als from the FE model. All materials in the model must have a unique name.

5.2.3 Using the material library

To use an existing material in the FE model, the user must first select the material in the library ma-
terial section. Using the right arrow button, the selected library material can be copied to the model
materials.

To add a user material to the material library the material must be created first using the Material
editor shown in Figure 15. Then the material library editor (Figure 14) can be used to add the user
material to the library. In the material library editor, a desired category must be selected or created
first and then the left arrow button can be used to copy the user material to the library. Once a material
is added to the library the changes must be saved for future use.

18
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Figure 15: Material library editor

5.2.4 Exchanging material data between users

All material data in the material library can be replaced by replacing the materials.lib file. In this
way the whole materials library can be sent to a second user. But replacing the library file also removes
all the changes done by the second user.

If only a selected material is to be exchanged with the second user, a PrePoMax model .pmx file
must be used. The first user creates a simple (but not empty) model containing the selected user
material. This file must then be sent to the second user who opens the model file and adds the user
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material from the file to his materials library using the Material library editor (Figure 15).
Usage of the Material library is presented in the following video: PrePoMax & CalculiX - Material

Library.
When a new material is created, it is possible to define:

• Density,

• Elasticity

– Young's modulus.

– Poisson's ratio.

• Plasticity

– Hardening:

* Isotropic.

* Kinematic.

* Combined.

– Data points (yield stress vs plastic strain).

• Thermal properties

– Thermal expansion:

* Thermal expansion coe�cient.

* Zero temperature.

– Thermal conductivity.

– Speci�c heat.

The arrow button is used to add a selected property to the new material definition.
It’s also possible to specify the material’s name, provide the description and include temperature

dependency (Use temperature dependent data points).
There are three available section types:

• Solid section

– Name – specify the section name.

– Material – select the material for the section.

– Thickness – specify the thickness of plane stress/strain part (only for 2D models).

– Region – select the region for the section assignment.

• Shell section

– Name – specify the section name.

– Material – select the material for the section.

– Thickness – define the shell thickness.

– O�set – set the offset of the shell mid-surface (shell thickness is the unit).

– Region – select the region for the section assignment.

• Membrane section

– Name – specify the section name.

– Material – select the material for the section.

– Thickness – define the membrane thickness.

– O�set – set the offset of the membrane mid-surface (membrane thickness is the unit).

– Region – select the region for the section assignment.

20
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5.3 Interaction Menu

Figure 16: Interaction menu

The Interaction menu (Figure 16) contains the following options:

• Constraint

– Create.

– Edit.

– Swap Master/Slave.

– Merge by Master/Slave.

– Hide.

– Show.

– Delete.

• Contact:

– Surface Interaction:

* Create.

* Edit.

* Duplicate.

* Delete.

– Contact Pair:

* Create.

* Edit.

* Swap Master/Slave.

* Merge by Master/Slave.

* Hide.

* Show.

* Delete.

• Search Contact Pairs.

Available constraints include:

• Point spring:

– Name.

– Region.

– Sti�ness:

* K1 – stiffness per node in the X direction.

* K2 – stiffness per node in the Y direction.
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* K3 – stiffness per node in the Z direction.

– Color.

• Surface spring:

– Name.

– Region.

– Sti�ness:

* K1 – stiffness per node in the X direction.

* K2 – stiffness per node in the Y direction.

* K3 – stiffness per node in the Z direction.

– Color.

• Rigid body:

– Name.

– Reference point.

– Region.

– Color.

• Tie:

– Name.

– Position tolerance – the largest distance from the master surface for which the slave nodes
will be included in the tie constraint (default: 2.5% of the typical element size).

– Adjust – projection of the slave nodes on the master surface.

– Master region.

– Slave region.

– Master surface color.

– Slave surface color.

The rigid body constraint requires a reference point since it constrains the motion of the selected
nodes to the motion of the reference point. It is used to define a selected region as infinitely rigid
(non-deformable). For example, it’s often used when modelling manufacturing tools. However, it
may also serve as a way to apply moments and remote loads to models. Rigid body constraint is
the only way to apply a torque to the surface of a solid part (since solid element nodes don’t have the
rotational degrees of freedom). Its usage in aforementioned applications is presented in the following
videos: PrePoMax (CalculiX FEA) - Tutorial 8 - Remote load and PrePoMax (CalculiX FEA) - Tutorial 2
- Torsion of an elliptical bar.

The tie constraint works like a bonded/welded contact. It connects two surfaces in such a way
that they can’t separate or move relative to each other during the analysis, they are permanently con-
nected. Tie constraint is often used to connect parts with dissimilar meshes. Its usage is presented
in the following video: PrePoMax (CalculiX FEA) - Tutorial 11 - Four-point bending of a sandwich
composite beam.

Contact is a more complex form of interaction between two surfaces than the tie constraint. It
allows the transfer of forces between touching surfaces. However, contact is a highly nonlinear phe-
nomenon and requires careful usage as it may cause convergence issues. When defining contact, a
surface interaction must be created first. Three options are available:
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• Surface behavior – behavior of the contact in the normal contact direction (pressure-overclo-
sure relationship)

– Hard.

– Linear.

– Exponential.

– Tabular.

– Tied.

• Friction – behavior in the tangential direction

– Friction coe�cient.

– Stick slope.

• Gap conductance – thermal conductance across the contact interface

– Constant

– Tabular – pressure and temperature dependent

When the surface interaction is created, the contact pairs can be defined. The options here are as
follows:

• Name

• Surface interaction

• Method

– Surface to surface.

– Node to surface.

• Adjust – projection of the slave nodes on the master surface.

• Adjustment size – distance inside which the slave nodes are projected to the master surface.

• Master region

• Slave region

• Master surface color

• Slave surface color

The usage of contact is presented in the following videos: PrePoMax & CalculiX - GUI Contact and
PrePoMax (CalculiX FEA) - Tutorial 10 - Hertz contact.

The Search Contact Pairs tool with exemplary input is shown in Figure 17. This tool allows users
to automatically create contact pairs and tie constraints. Upon clicking the Search button this tool
searches for surface pairs that meet the following criteria:

• distance between them is smaller or equal to the specified distance.

• angle between them is smaller or equal to the specified angle.
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Figure 17: Search Contact Pairs tool

In addition to these criteria, user may choose whether the pairs are grouped by parts or not. Before
performing the search, one can change the type of interaction (Contact or Tie), specify previously
created contact property definition and choose the type of contact (surface to surface or node to
surface). For both contact and tie creation, it’s possible to enable or disable adjustment. After the
search, users can still change the aforementioned settings (as well as position tolerance and name of
the pair) using the Data window on the right side of the tool. In addition, right clicking on the pair
in Contact Pairs window brings an option to swap master and slave surfaces. When more than one
pair is selected, an option to merge by master/slave also becomes available. The usage of this tool is
presented in the following videos: PrePoMax (CalculiX FEA) - Tutorial 14 - Chain links and PrePoMax
(CalculiX FEA) - Tutorial 15 - Shell-to-solid connection.

5.4 Initial Condition Menu

Figure 18: Initial condition menu

The Initial condition menu (Figure 18) contains the following options:

• Create.

• Edit.

• Delete.

The following initial condition types and settings are available:

• Temperature – can be used to specify the temperature at the beginning of the transient thermal
or thermo-mechanical analysis

– Name.
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– Region.

– Temperature.

5.5 Step Menu

Figure 19: Step menu

The Step menu (Figure 19) contains the following options:

• Step

– Create.

– Edit.

– Duplicate.

– Delete.

• History Output

– Create.

– Edit.

– Propagate.

– Delete.

• Field Output

– Create.

– Edit.

– Propagate.

– Delete.

• BC – Boundary condition

– Create.

– Edit.

– Propagate.

– Hide.

– Show.

– Delete.

• Loads
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– Create.

– Edit.

– Propagate.

– Hide.

– Show.

– Delete.

• De�ned Field

– Create.

– Edit.

– Propagate.

– Delete.

5.5.1 Step

The step types and their options available in PrePoMax are:

• Static step

– Name.

– Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky.

– Nlgeom: On/Off (enable or disable the geometric nonlinearity – large deformations and
large displacements).

– Incrementation: Default/Automatic/Direct (the options listed below are for Automatic in-
crementation).

– Max increments – maximum number of increments in the step.

– Time period – time period of the step.

– Initial time increment – initial value of time increment in the step.

– Min time increment – minimum time increment allowed.

– Max time increment – maximum time increment allowed.

• Frequency step

– Name.

– Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky.

– Perturbation: On/Off (when it’s set to On, preload from previous static step can be in-
cluded).

– Storage: Yes/No – stores eigenvalues, eigenmodes, mass and stiffness matrix in a binary
form in a file jobname.eig for further use.

– Number of frequencies – number of eigenfrequencies to compute.

• Buckle step

– Name.

– Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky.

– Perturbation: On/Off (when it’s set to On, preload from previous static step can be in-
cluded).
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– Num of buckling factors – number of buckling factors desired (default: 1).

– Accuracy – accuracy desired (default is 0.01).

• Heat transfer step

– Name.

– Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky.

– Steady state: Yes/No – switching between the steady state and the transient analysis

– Incrementation: Default/Automatic/Direct (the options listed below are for Automatic in-
crementation).

– Max increments – maximum number of increments in the step.

– Time period – time period of the step.

– Initial time increment – initial value of time increment in the step.

– Min time increment – minimum time increment allowed.

– Max time increment – maximum time increment allowed.

• Uncoupled temperature-displacement step

– Name.

– Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky.

– Nlgeom: On/Off (enable or disable the geometric nonlinearity – large deformations and
large displacements).

– Steady state: Yes/No – switching between the steady state and the transient analysis

– Incrementation: Default/Automatic/Direct (the options listed below are for Automatic in-
crementation).

– Max increments – maximum number of increments in the step.

– Time period – time period of the step.

– Initial time increment – initial value of time increment in the step.

– Min time increment – minimum time increment allowed.

– Max time increment – maximum time increment allowed.

• Coupled temperature-displacement step

– Name.

– Solver: Default, PaStiX, Pardiso, Spooles, Iterative scaling, Iterative Cholesky.

– Nlgeom: On/Off (enable or disable the geometric nonlinearity – large deformations and
large displacements).

– Steady state: Yes/No – switching between the steady state and the transient analysis

– Incrementation: Default/Automatic/Direct (the options listed below are for Automatic in-
crementation).

– Max increments – maximum number of increments in the step.

– Time period – time period of the step.

– Initial time increment – initial value of time increment in the step.

– Min time increment – minimum time increment allowed.

– Max time increment – maximum time increment allowed.
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5.5.2 History Output

History output is used to generate X-Y plots in post-processing. Available options include:

• Node output

– Name.

– Frequency – results of every N-th increment will be saved.

– Variables to output

* RF – reaction forces.

* U – displacements.

* NT – temperatures.

* RFL – external concentrated heat sources.

– Totals – this parameter applies to the external forces, it enables output of values summed
for all nodes in the set.

– Region – region for creation of the history output.

• Element output

– Name.

– Frequency – results of every N-th increment will be saved.

– Variables to output

* S – true (Cauchy) stress.

* E – total Lagrangian strain or total Eulerian strain.

* ME – mechanical Lagrangian strain or mechanical Eulerian strain.

* PEEQ – equivalent plastic strain.

* HFL – heat flux.

* ENER – energy density.

* ELSE – internal energy.

* EVOL – volume.

* EBHE – heating power.

– Totals – this parameter applies to the whole element variables (ELSE, EVOL), it enables
output of values summed for all elements in the set.

– Region – region for the creation of the history output.

• Contact output

– Name.

– Frequency – results of every N-th increment will be saved.

– Variables to output

* CDIS – relative contact displacements.

* CSTR – contact stresses.

* CELS – contact energy.

* CNUM – total number of contact elements.

* CF – total contact forces on slave surface.

– Totals – this parameter applies to the energy (CELS).

– Contact pair – contact pair for creation of the history output.

No history outputs are created by default.
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5.5.3 Field Output

Field output is used to create contour plots. Available options include:

• Node output

– Name.

– Frequency – results of every N-th increment will be saved.

– Last iterations: On/O� – disabled by default, turning it on enables storage of results from
all iterations of the last increment in a separate file named ResultsForLastIterations.frd
and can be useful for debugging of diverging analyses.

– Contact elements: True/False – disabled by default, turning it on enables storage of con-
tact elements in a file with .cel extension and their display in results.

– Variables to output:

* RF – reaction forces.

* U – displacements.

* NT – temperatures.

* RFL – external concentrated heat sources.

• Element output

– Name.

– Frequency – results of every N-th increment will be saved.

– Last iterations: On/O� – disabled by default, turning it on enables storage of results from
all iterations of the last increment in a separate file named ResultsForLastIterations.frd
and can be useful for debugging of diverging analyses.

– Contact elements: True/False – disabled by default, turning it on enables storage of con-
tact elements in a file with .cel extension and their display in results.

– Output (2D/3D):

* Default – results for shell elements are displayed in the expanded 3D form while for
plane stress/strain and axisymmetric elements they are displayed in the original 2D
form.

* 2D – results for all types of 2D elements are displayed in the original 2D form.

* 3D - results for all types of 2D elements are displayed in the expanded 3D form.

– Variables to output:

* S – stresses.

* E – total strains.

* ME – mechanical strains.

* PEEQ – equivalent plastic strain.

* ENER – energy density.

* HFL – heat flux.

* ERR – extrapolation error estimator for stress calculations (ERR and ZZS are mutually
exclusive).

* HER – extrapolation error estimator for heat calculations (HER and ZZS are mutually
exclusive).

* ZZS – Zienkiewicz-Zhu improved stress (ZZS and ERR are mutually exclusive).

• Contact output
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– Name.

– Frequency – results of every N-th increment will be saved.

– Last iterations: On/O� – disabled by default, turning it on enables storage of results from
all iterations of the last increment in a separate file named ResultsForLastIterations.frd
and can be useful for debugging of diverging analyses.

– Variables to output

* CDIS – relative contact displacements.

* CSTR – contact stresses.

* PCON – contact states for frequency calculations.

Default field outputs are created in each new step added to the model.

5.5.4 Boundary condition

Figure 20: Boundary Conditions submenu

The Boundary Conditions ( BC ) submenu (Figure 20) contains the following options:

• Create.

• Edit.

• Propagate.

• Hide/Show.

• Delete.

The following boundary condition types and settings are available:

• Fixed

– Name.

– Region.

– Color.

• Displacement/Rotation

– Name.

– Region.

– DOF:

* U1 – translation in X axis.
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* U2 – translation in Y axis.

* U3 – translation in Z axis.

* UR1 – rotation about X axis.

* UR2 – rotation about Y axis.

* UR3 – rotation about Z axis.

– Color.

• Submodel

– Name.

– Step number – global model step number from which to read the displacements.

– Region.

– DOF:

* U1 – translation in X axis.

* U2 – translation in Y axis.

* U3 – translation in Z axis.

* UR1 – rotation about X axis.

* UR2 – rotation about Y axis.

* UR3 – rotation about Z axis.

– Color.

• Temperature

– Name.

– Region.

– Magnitude.

– Color.

Fixed boundary condition constrains all the available degrees of freedom (DOF). Displacement/rotation
BC allows the user to select individual DOFs. The following options are available for each DOF:

• Unconstrained – no boundary condition imposed on this DOF.

• Fixed – freezes the deformation from the previous step or, if there is no previous step, sets it to
zero.

• Value (length unit/angle unit) – a prescribed value of displacement (current length units for
translational DOFs and radians for rotational ones).

Keep in mind that a Fixed option and a Value option cannot be used simultaneously for various DOFs
in the same boundary condition.

In the case of a submodel boundary condition, each DOF has the following two options:

• Unconstrained.

• From global model.

Usage of submodeling technique is presented in the following videos: PrePoMax & CalculiX - Sub-
model and PrePoMax (CalculiX FEA) - Tutorial 13 - Stress concentration - submodeling.
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Figure 21: Load submenu

5.5.5 Load

The Load submenu (Figure 21) contains the following options:

• Create.

• Edit.

• Propagate.

• Hide/Show.

• Delete.

The types of loads and their options are listed below:

• Concentrated force

– Name.

– Region.

– Force components – components of the concentrated force per node:

* F1 – force in the X axis.

* F2 – force in the Y axis.

* F3 – force in the Z axis.

– Magnitude – resultant force (it’s calculated automatically when the components of the
force are specified).

– Color.

• Moment

– Name.

– Region.

– Moment components – components of the moment per node:

* M1 – moment about the X axis.

* M2 – moment about the Y axis.

* M3 – moment about the Z axis.

– Magnitude – resultant moment (it’s calculated automatically when the components of the
moment are specified).

– Color.
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• Pressure

– Name.

– Region.

– Magnitude – value of the pressure load.

– Color.

• Surface traction

– Name.

– Region.

– Force components:

* F1 – force in the X axis.

* F2 – force in the Y axis.

* F3 – force in the Z axis

– Magnitude – resultant force (it’s calculated automatically when the components of the
force are specified).

– Color.

• Normal shell edge load

– Name.

– Region.

– Magnitude – value of the shell edge load.

– Color.

• Gravity

– Name.

– Region.

– Gravity components:

* F1 – gravitational acceleration in the X axis.

* F2 – gravitational acceleration in the Y axis.

* F3 – gravitational acceleration in the Z axis.

– Magnitude – resultant acceleration (it’s calculated automatically when components of the
force are specified).

– Color.

• Centrifugal load

– Name.

– Region.

– Axis point – coordinates of the axis point:

* X.

* Y.

* Z.

– Axis direction:
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* N1 – axis component in the direction of the X axis.

* N2 – axis component in the direction of the Y axis.

* N3 – axis component in the direction of the Z axis.

– Rotational speed – rotational speed around the axis defined by a point and a direction.

– Color.

• Pre-tension

– Name.

– Type: Force/Displacement.

– Region.

– Auto compute: Yes/No – automatic computation of the pre-tension direction.

– Magnitude – force or displacement magnitude for the pretension load.

– Color.

• Concentrated �ux

– Name.

– Add �ux: Yes/No – add flux to the previously defined fluxes.

– Region.

– Flux – value of the flux per node.

– Color.

• Surface �ux

– Name.

– Region.

– Flux magnitude per surface area.

– Color.

• Body �ux

– Name.

– Region.

– Flux magnitude per volume.

– Color.

• Convective �lm

– Name.

– Region.

– Sink temperature.

– Convective �lm coe�cient.

– Color.

• Radiation

– Name.
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– Cavity radiation: Yes/No – an option to make the selected surfaces belong to a radiation in
a cavity (cavity name has to be specified if this option is switched to Yes)

– Region.

– Sink temperature.

– Emissivity – surface emissivity, blackbody radiation is characterized by 1.

– Color.

Surface traction load internally applies concentrated forces to each node on the selected surface.
Their values sum up to the total magnitude specified in the load definition window. If multiple sur-
faces are selected, the load acting on each of them sums up to the value specified in the load definition
window.

Despite the name, gravity load can be used to prescribe any type of translational acceleration to
the structure (such as deceleration due to braking or acceleration of the vehicle). Its usage is pre-
sented in the following videos: PrePoMax & CalculiX - Gravity and PrePoMax (CalculiX FEA) - Tutorial
7 - Gravity load.

Pre-tension is a specific type of load that requires some special considerations. Prior to defin-
ing it, a boundary layer needs to be created. Pre-tension load should be disabled in the second
step of the analysis, when actual loading is applied to the model. This can be done by changing
the displacement-type pre-tension setting to Fixed. Usage of this type of load is presented in the
following video: PrePoMax & CalculiX - Pre-tension - Bolt.

Items such as constraints, contact pairs, steps, boundary conditions and loads can be activated
or deactivated (excluded from the analysis without the need to delete their definitions completely).

Below the menu bar there is a Symbols dropdown list, that allows the selection of how the symbols
are displayed (None, Model, Step-1, . . . ).

5.5.6 Defined Field

Defined fields are used to prescribe predefined values to the nodes. The types of predefined fields
and their options are listed below:

• Temperature – can be used to specify temperature field for static or buckle step

– Name.

– De�ne temperature: By value.

* Region.

* Temperature.

– De�ne temperature: From �le

* Results file.

* Step number.

5.6 Analysis Menu

The Analysis menu (Figure 22) contains the following options:

• Create.

• Edit.

• Run – submit the analysis.
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Figure 22: Analysis menu

• Monitor – open the window that displays solver messages.

• Results – open results of the completed analysis.

• Kill – stop the analysis before it finishes.

• Delete.

6 Results options

The Results tree consists of the following containers:

• Mesh

– Parts.

– Node sets.

– Element sets.

– Surfaces.

• Results

– Field outputs.

– History outputs.

6.1 Results Menu

Figure 23: Results menu

The Results menu (Figure 23) contains the following options:

• Part

– Edit.

– Hide, Show and Show only.
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– Set Transparency.

– Color Contours o�.

– Color Contours on.

– Delete.

• Transformation – a mirror or a pattern can be applied to the results for the visualization pur-
poses (use the button to add the transformation to the Active part of the window to apply
it)

– Symmetry – a symmetry point has to be selected

* Name.

* X.

* Y.

* Z.

– Pattern

* Linear

· Name.

· Number of items.

· Start point.

· End point.

* Circular

· Name.

· Number of items.

· Angle.

· First axis point.

· Second axis point.

In addition to these options, selecting more than one part in the Results tree and right-clicking on this
selection enables users to activate the Merge Parts option that creates a single results part.

Figure 24: Results toolbar

Selected post-processing options are also available as shortcuts in the Results toolbar (Figure 24).
These options include:

1. Undeformed.

2. Deformed.

3. Deformed with color contours.

4. Transformation.

5. First increment.

6. Previous increment.

7. Drop-down list of increments.
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8. Next increment.

9. Last increment.

10. Animate.

Figure 25: Animation window

There are several settings for animating the results. They are shown in Figure 25.
Point Node query tool has additional functionality in the Results module – it allows the user to

check the value of the currently shown output variable at the selected node.
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